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Information Delivery Portal Portlet
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This paper describes the “shortest path” from having an ITRM Enterprise Guide 
report ready to publish to end users viewing it in a portlet in the SAS® 
Information Delivery Portal. The paper assumes the products have already been 
installed and focuses on the implementation of publishing reports into the portal. 
The paper also covers some of the application choices that can be made, the 
implications, the various tool inter-relations and the tradeoffs. Publishing one-
time reports, scheduled/recurring reports, and stored processes will be covered 
with a focus on minimizing maintenance.

Introduction

There are many documents that each describes in varying levels of detail how to use the 
various SAS products.  They discuss all the many options that can be selected, but don’t 
often explain how those choices effect the end results, or how they are dependent on 
other products not covered in that specific document.  

There are many options and possibilities, but this paper focuses on the “minimum” 
requirements to publish content from EG to a usable portlet in Portal with minimal 
maintenance, but maximum usefulness.  This document covers four different SAS 
products in the prescribed ITRM “standard” implementation and how they work together.  
When it makes sense, a couple options and their benefits and consequences will be
discussed.

The four different tools included in the following steps are, Enterprise Guide, Xythos, 
SAS Management Console, and SAS Information Delivery Portal.  To publish a report 
for the first time requires touching all four of these tools.

Most of this paper takes the form of a click by click How-To, but the real value of the 
paper is in the explanations within those clicks of why each choice should be made, as 
well as, the implications of making that choice to what will be visible to portal users.

There are a few cases where the order of the steps is not critical, but many of these steps 
do require that they be done in the sequence listed for the various tools to have their pre-
requisites met.  In other words you can do this in any order you want and it might work, 
and it might not, but in this order it will work.
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Create a “static” EG Report Worth Publishing

This paper will not explain how to create a report, but rather show some ideas how to 
format it so that it can be viewed and used in the portal effectively.

It is always important to have good titles and labels when producing a report, but it 
becomes especially critical when publishing to a web portal that could be viewed by 
almost anyone at any time.  When you email a report to someone you are able to include 
as much context, instruction, and explanation as is required because you know your 
intended audience and purpose.  When creating a web portal that can try to answer as 
many questions as possible for as many users as possible with the least effort possible it 
can’t be done without built in explanations.  The portal provides several places to provide 
this context, instruction, and explanation, but the only ones that will reside on the same 
page as the report are the Title, the axis labels, and the footnote so use them to the fullest.  
It is important to account for what is included in the report, but also what it excluded.

Even the best labeled reports will still have questions.  Those questions may come 
quickly after the report is published or may come long after you have forgotten how the 
report was developed, or even what project created the report.  A useful tip that will save 
you time and frustration by giving you beginning to end traceability is to include in the 
footnote of every report (best to include it in the default template) the global variables for 
the EG project name and the EG task name that is being published.

To edit the “Default Footnote” do the following in the EG client.  It should take less than 
1 minute to setup, but save hours later on.

1. Open EG 
2. Select Tools menu 
3. Select Options 
4. Select “Tasks General” 
5. Edit the “Default footnote text for task output” to be the following 2 lines

Generated by ITRM on %SYSFUNC(DATE(), EURDFDE9.) at %SYSFUNC(TIME(), 
TIMEAMPM8.)

&_CLIENTPROJECTNAME / &_EGTASKLABEL

This will put a created date and time on one line, and the EG project and EG task that 
created the report.  Now when someone asks a question about a report you can have them 
tell you the exact project and task that created the report without having to hunt for it.

Create a directory in Xythos Admin for the new report

There are a couple different types of publication channels (created in next step), but they 
both require a Xythos directory to put the resulting report(s) into for use by the portal.  

Reporting and Information VisualizationSAS Global Forum 2010

 



You can get very fancy with your settings, but the simplest method with a default 
installation is shown here.

1. Open and login to Xythos Admin  (http://server:8300/xythosadmin)
2. Select “File System”
3. Select “List All Top-Level Directories”
4. Select “sasdav”
5. Select “wrs”
6. Select “Add New Sub-Directory”
7. Enter the name of the directory you desire.  For traceability, it can be convenient 

to give this directory the same name as the Publication Channel created in the 
next major step.

8. Optionally change the Quota.  “Unlimited” will prevent a problem with that one 
directory filling up, but might allow that one directory to effect the overall file 
system space on the system and therefore cause problems for other published 
reports.  With that said 20 MB is quite a few reports, and will usually be 
sufficient.

9. Select “Create Directory”

Create a Publication Channel in SAS Management Console to connect EG to Xythos

A “Publication Channel” must be created for each report that will be regularly updated 
automatically, or for each group of reports that will be created once and left alone (ad-hoc 
requests).

NOTE:  There is no good/automated way to delete publication channels from the portal, 
even though some menus are offered, but don’t work.  There is a java program available 
from SAS support, but better to be sure you build the ones you want.

1. Connect to the Foundation repository of the metadata server with SAS 
Management Console.

2. Expand the “Publishing Framework”
3. Expand the “omi://[server]:8561”
4. Right click on “Channels” and select “New Channel”
5. Enter the name for this new Publication Channel. (For traceability it can be 

convenient to give this channel the same name as the Xythos directory created in 
the previous major step.)

6. Enter a description (viewable in EG when selecting a channel to publish to)
7. Select Next (no changes required on the “Associate package and event subscribers 

to this channel” Page
8. Select the WebDAV option
9. Enter the Relative Path = Xythos directory created in previous major step.  This is 

the directory that is within …/sasdav/wrs directory that you want to publish to.  If 
this directory does not exist before creating this Publication Channel then it won’t 
work.

10. Select the URL type (2 options)
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a. For a report that will be regularly updated (for example: a daily report 
using the previous day’s data) select the “Collection” URL type.  This 
URL type only allows a single file to be placed here.  Any future attempts 
to publish to this channel will overwrite the previous publication, thus 
making it good for content that is regularly updated.

b. For reports (one or many) that will be published a single time select the 
“Parent” URL type.  This URL type allows many files to be placed here, 
but if additional files are published they will not overwrite the previous 
ones.  This content type is good for ad-hoc requests for information to 
allow multiple reports to be placed in a single Xythos directory and single 
Publication channel (reducing maintenance time to create many), but it 
will need to be cleaned up manually since the directory is additive.

11. Select Next (verify selections and labels and go back to edit if necessary)
12. Select Finish
13. Restart EG (to recognize the new Publication Channel) and re-run the report from 

the beginning.  EG only lists Publication Channels that exist when it first connects 
to the metadata server so this step is required any time you will publish to a newly 
created Channel.

Publish the report from EG to the Publication Channel

1. Right click on the report(s) that you would like published and select “publish”
2. Give a title to the package (For traceability it can be convenient to give this task 

the same name as the channel and the Xythos directory created in the previous 
major steps.)

3. Enter a description.  This description will be visible in collection portlets in the 
portal so this is a great place to include instructions, explanations, or context for 
this report.  This description will also show up when searching in the portal.  In 
other words this description will be visible to users so make it meaningful.

4. Optionally define an expiration date when the report should become unavailable.
5. Click “Next” (assuming you only have one metadata server)
6. Select the Publication Channel you created for this report (created in previous 

section).
7. Highlight the report from the list on the left.
8. Select “Item Properties” from the right side.  
9. Edit the “Description” field to be descriptive of the report.  If this is not edited 

then the report title once the package is selected in the portal/portlet will be 
“HTML Report” which is not very descriptive.

10. Select “OK”
11. Select “Finish”

Configure the Portal to show the report(s)

1. Login as SAS web admin.
2. Create a “page” in Portal (basically a tab, that can have the “share type” (default, 

sticky, available) and “location” (which single group can view it).
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a. Select the “Options” menu, and select “Add” from the drop down in the 
“Pages” section.

b. Give the page a Name, or in other words label the tab.
c. Description and Keywords are optional, but are not readily visible to the 

public.
d. Rank is optional to edit, but controls the sequence of tabs from left to right 

or top to bottom.
e. Change the “Location (group)” value to the group of portal users who 

should have access to view this page.
f. If you select any group other than “Not Shared” then you will need to 

select a “Share type” as well.  There are 3 options.  “Available” will create 
a page that if people search for it they will be able to find and add to their 
personal portals.  “Default” will place the page in the portal for all 
members of the assigned group, but they can remove it from their portal if 
they want to.  “Sticky” will place the page in the portal for all members of 
the assigned group, but they will NOT be able to remove it. More frequent 
or power portal users will appreciate the flexibility of  “Available” (put 
how do you tell people new content is available) or “Default”, but 
infrequent users, and especially any shared portal ID’s will prefer the 
Sticky option so they can’t remove content in ignorance of the impact.

g. Select “Add”
h. Select “Done”

3. Create a “portlet” in Portal.  A portlet in this application is simply a rectangular 
space to put something else in.  The actual content/report will be placed in the 
portlet in a later step.

a. Select the “Options” menu from the top right of the screen, and select 
“Create New Content” from the drop down in the “Tools” section.

b. Select “Portlet” and then “Create”
c. Select the portlet type

i. Collection Portlet = a list of content, like reports
ii. URL Display Portlet= shows the content of a URL that is included

in the portlet (iFrame has worked for me)
c. Give the portlet a “Name” that will be searchable, and visible/informative 

to the end user.  Remember this name since you will search for it in step 4.
d. Again “Description” and “Keywords” are optional and not readily visible 

to the end user.
e. Change the “Location (group)” value to the group of portal users who 

should have access to view this portlet.
f. Select “Create”
g. Select “Done”
h. Select “Done” or create another portlet/page/link etc.

4. Add the portlet to the page/tab
a. Select the page/tab you created in step 2.
b. Select the “Options” menu from the top right of the screen, and select 

“Edit Content” from the drop down in the “Current Page” section.
c. Select “Add Portlets”
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d. Select the “Search” tab
e. Enter the name of the portlet(s) you want to add and select “Search”
f. Select the box next to each portlet you would like to add to this page.
g. Select “Add”  (a message will appear at the top saying “# portlet(s) 

added.”)
h. Select “Done”
i. Select “OK”

5. Add item(s) to the portlet(s).
a. In the top right corner of each portlet (not of the whole screen) you will 

see the group that is allowed to view that portlet as well as four items to 
select (only 3 available at this point).

b. Select the icon that looks like a pencil to paper.  If you mouse over it will 
say “edit content”.

c. For a “Collection Portlet” 
i. Select “Add Items”

ii. Select the “Search” tab
iii. Select the type of content and enter any keywords (* is allowed) 

for the type of content you want to include in this portlet, then 
select “Search”.  The report published earlier from EG will have a 
“content type” of “Package”

iv. Select the box next to each item you would like to add to this 
portlet.  (In my environment “Package” and “SAS Stored Process” 
are most common.)

v. Select “Add”  (a message will appear at the top saying “# item(s) 
added.”

vi. Select “Done”
vii. Deselect “Show description” if you don’t want the description 

created for the report back when publishing in EG to show in the 
portlet list of items.  I usually leave this option selected since it 
prevents the user from having to go into the report to get more 
detail than just the report name.

viii. Deselect “Show location” if you don’t want the path to the item on 
the Metadata server to be visible in the portlet.  I usually deselect 
this item since it takes up space and doesn’t provide most users 
with information they need.

ix. You can also use the arrow keys on the right of the box to change 
the order the items will be displayed.

x. Select “OK”
d. For a “URL Display Portlet”

i. Enter the URL you would like to show the content of in the portlet.  
Be sure the portal has access to the URL (not protected by 
firewalls or proxy servers for example).  

ii. Optionally select the “Show URL content inside an I-Frame”.  For 
simple text or HTML content it works well without an I-Frame and 
then the sizing is minimized to the content, but for more complex 
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URL’s (e.g. SAS Stored Process pages) it doesn’t work without an 
I-Frame.

iii. Optionally change the “I-Frame Height” dependent on how much 
of the site you want viewable inside the portlet without scrolling.

iv. Select “Save”

Export SAS code from EG and schedule to run and update automatically.

1. Run the full process flow in EG that you want to export.
2. Select the “File” menu
3. Select “Export” and then “Export All Code”
4. Select “Browse” and choose where the SAS code should be placed and what it 

should be named.
5. Edit the code if necessary?  (perhaps need to make the same “where” clause edit 

as in the “Publish a Stored Process” section of this paper.
6. Select “Export”
7. Schedule that exported code in your scheduling system to run the day(s) and 

time(s) desired.

Publish a Stored Process to the Portal
1. Create a report with parameters in EG worth publishing. (same guidelines as for 

“static”/non-parameterized reports)
2. Run the report from beginning to end in EG as a user with authority to create and 

that will not be impacted by having the credentials hard coded into the stored 
process.  In other words try to use a user that has a “permanent” password to 
prevent you needing to update the stored process each time the password changes.

3. Right Click in the process flow and select “Create stored process”
4. You may get a warning telling you the stored process will be run with hard coded 

credentials.
5. If dates were used as parameters you will likely get a “Parameter Translation 

Problem” warning.  This warning will be addressed in a later step so select 
“close” at this point.

6. Give the Stored Process a “Name”.  This name will be searched for and visible in 
the portal so make it meaningful to the end user.

7. Enter a description of the Stored Process that will also be visible in the portlet by 
the end user.  This is a good place to put instructions for the user on how to use 
the stored process including any guidance on how to interpret the results.  For
example: “Select the start and end date (in the last 12 weeks, and not today), and the 
LPAR you are interested in.”

8. Select “Next”
9. If dates were used as parameters, find the “WHERE” clause that refers to those 

parameters and make the following edits to all date parameters
a. Change       &StartDate       to         “&StartDate”d
b. In other words, surround the existing parameter with double quotes and 

add a “d” after the close quote.
10. Select “Next”
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11. Select “Choose Location”
12. Select a Metadata Location directory to store the stored process in.  I have had 

mixed results with this step, but SAS support says it should work best to use a 
directory in the ITMS repository.  I have had success publishing Stored Processes 
to directories in both ITMS and Foundation repositories, but the behavior from 
the portal side has been different depending on the choice.

13. Select “Next” to go to step 4 of 8
14. Select “Next” to go to step 5 of 8
15. Select “Next” to go to step 6 of 8
16. This screen controls the order the parameters will be shown to the portal user.  

Select any parameter that should be viewed in a different order than shown and 
use the arrows at the bottom right of the window to change the order.

17. Select “Add” and then “New Parameters”
a. Type “_GOPTIONS”  (without the quotes) in the “User prompt” field
b. Type “_GOPTIONS”  (without the quotes) in the “SAS variable name” 

field
c. Select the “Default Value” check box
d. Type “DEVICE=ACTIVEX” (without the quotes) in the field to the right 

of the “Default Value” check box
e. Deselect the “Modifiable” check box
f. Deselect the “Visible” check box
g. Select “Add”
h. Select “Close”
NOTE: Some users may not need this step since it should be just resetting a 
default, but without this step the Stored Process results can’t be returned to the 
portal in our environment.

18. Select “Next” to go to step 7 of 8
19. Select “Streaming output” (again to avoid errors when viewing in the portal)
20. Select “Next” to go to step 8 of 8
21. Select “Finish”
22. Follow the steps in the “Configure the Portal to show the report(s)” section of 

this paper to place the Stored Process in a portlet.
a. Create a “page” in Portal, or reuse existing
b. Create a “portlet” in Portal or reuse existing

i. Collection portlet type (does require activeX parameter addition)
ii. URL portlet type (does NOT require activeX parameter addition)

c. Add the new Stored Process to the portlet
i. Collection portlet (same as using a report published through a 

channel)
ii. Get the URL of the Stored Process to configure the URL portlet

1. From the Portal front page select “Search” in the top right 
of the window.

2. Enter the name (or a portion of the name) in the 
“keywords” field.

3. Select “SAS Stored Process”
4. Select “Search”
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5. Select the link (in the “Name” column) to the Stored 
Process.

6. Copy the resulting URL from your browser and use it with 
an I-frame when configuring the URL portlet method.

Custom “Welcome Portlet” etc.

SAS Information Delivery Portal comes out of the box with a “Welcome” portlet, but the 
text of that portlet cannot be edited.  There is a need for a portlet that provides an 
introduction or some education on how to use the portal.  A reasonable, however not 
necessarily intuitive, solution to this is to use URL portlets and point them to html files 
that contain the desired content.  

A URL portlet can be used to point to any URL on any available web server, but for these 
simple “Welcome” or “Text” portlets it seems simplest to use the same web/application 
server that Portal uses.  A “fancy” html page can be created or a simple text file can be 
used depending on your specific objective.

To use the ID Portal webserver for this content you can place your new files in the 
following directory: ……./jakarta-tomcat-4.1.18/webapps/ROOT/[newFile.html]

The following URL can be used in the URL portlet to view the content of that file in the 
portal:  http://server:8080/newFile.html

This same solution can also be used for user instructions in the portal, announcements, 
FAQ’s, or other resources available to the user on the intranet without them going to 
another portal.

Conclusion

The SAS Information Delivery Portal has a great deal of flexibility and many options 
available for use with ITRM.  However, sometimes those options and their implications 
in future steps are not always obvious.  Every site that uses ITRM and the portal will use 
the tools differently, but the steps and concepts in this paper will provide a great starting 
point to get useful reports out quickly, reliably, and with minimal future maintenance.

Appendix:
Reference the version and platform of each of the applications involved.
Enterprise Guide 4.1 on XP
Xythos 4.2.35.3 on Solaris
SAS Management Console 9.1 on XP with metadata server on mainframe
SAS Information Delivery Portal v913sp4
Tomcat 4.1.18 on Solaris

SAS and all other SAS Institute Inc. product or service names are registered trademarks or 
trademarks of SAS Institute Inc. in the USA and other countries. ® indicates USA registration. 

Other brand and product names are trademarks of their respective companies.
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